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CosmoLex Offers 
Additional Discount
Through End of November
By Laura Calloway, director, ASB Service
Programs, laura.calloway@alabar.org
As lawyers in smaller firms know, “ad-

ministrative” mistakes–such as missed
deadlines, inaccurate bills and improper
or missed trust account reconciliations–
can be costly, resulting in lost clients,
malpractice claims and professional dis-
cipline. Wise lawyers adopt systems to
avoid these problems and take the
focus off administrivia, allowing them to
spend their time doing what they do
best–practicing law.
CosmoLex, one of the Alabama State

Bar’s newest member benefits, has just
made it much easier to stay on top of
practice management functions with
the release of a state-of-the-art, com-
prehensive, cloud-based practice man-
agement tool, CosmoLex Cloud. And,
while you may have seen prior versions
of CosmoLex, this new release takes the

service to an entirely different level.
CosmoLex is unique in the way that

everything is integrated intuitively, built
from the ground up for the sole purpose
of enabling law firm practice manage-
ment, so everything, like tasks or ex-
penses, is attached to a client matter.
And meetings in the calendar can be set
as “billable”–to flow into the invoicing
stream upon completion. The trust ac-
counts section prevents common trust
bookkeeping mistakes such as over-
drafts, and automates bank reconcilia-
tions and three-way reconciliation,
facilitating working with auditors.
The Alabama State Bar has arranged

for you to receive a 10 percent lifetime
discount on CosmoLex Cloud, and an 
additional 5 percent lifetime discount is
available for those who sign up before
November 30, reducing the user fee to
$43 per month (billed annually and proof
of ASB membership required). Call (866)
878-6798 or go to www.cosmolex.com 
for details on how to start your 30-day
free trial. �

MEMBER BENEFIT SPOTLIGHT
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The 
“Distinguishable
Judge Roast”

MCBA Presents Ninth 
Annual Charity Event
The “Distinguishable Judge Roast” hon-

oring Judge Charles Price for his 31 years
of service as a circuit judge in Mont-
gomery County will be November 14 at
the Renaissance Montgomery Hotel &
Spa at 201 Tallapoosa Street. Sponsored
by the Montgomery County Bar Associa-
tion, the event begins at 5:15 p.m. with a
reception and silent auction. The dinner
and roast start at 7:00.
Admission is $75 per person and dress

is cocktail attire. Tickets, sponsorships and
other opportunities may be purchased at
www.mcbar.org, by calling the MCBA at
(334) 265-4793 or by mailing a check to:

Montgomery County Bar Association
P.O. Box 72
Montgomery AL 36101

All proceeds benefit Mary Ellen’s Hearth
at Nellie Burge Community Center, Med-
ical Outreach Ministries and the Mont-
gomery Volunteer Lawyers Program.
A block of rooms has been reserved at

the Renaissance for out-of-town guests
(http://www.marriott.com/hotels/travel/
mgmbr-renaissance-montgomery-hotel-
and-spa-at-the-convention-center/).
Purchase your tickets today! �

Price

The Alabama Lawyer Assistance Pro-
gram announces its support of a stress
study being conducted by University of
Alabama School of Law Professor
Pamela Pierson.
Mental health issues, such as depres-

sion, anxiety, substance abuse and bipo-
lar disorder, and the tragic reality of
suicide among attorneys have become
topics of urgency among many around
the country. It is widely known that at-
torneys suffer from depression and sub-
stance use disorders at roughly twice
the rate of the general population, and
that the suicide rate is also twice that of
the general population.
Participation in this survey will not

take much of your time, and it may play
an important role in identifying those
traits that precipitate unhealthy stress
and other mental health issues, as well
as those traits of “stress hardiness” that
seem to be possessed by those who
handle stress well.

The Alabama Lawyer Assistance Pro-
gram applauds the efforts of Professor
Pierson and her colleagues, and encour-
ages attorneys to take a few minutes to
complete the survey.
Survey results are completely confi-

dential. This version requires responses
so you will have to take it to review it. To
begin the survey, go to https://university
ofalabama.az1.qualtrics.com/SE/?SID=SV
_2tyV2k6G54KqReJ. �

Thornhill Pierson

A L A P :
Do Something Good for
Your Profession and 

Participate in Stress Study

By Robert Thornhill, MS, LPC, director, Alabama Lawyer Assistance Program,
robert.thornhill@alabar.org



IMPORTANT NOTICES
Alabama Lawyers’ 
Hall of Fame
May is traditionally the month when

new members are inducted into the Ala-
bama Lawyers’ Hall of Fame located at
the state judicial building. The idea for a
hall of fame first appeared in 2000 when
Montgomery attorney Terry Brown
wrote state bar President Sam Rumore
with a proposal that the former
supreme court building, adjacent to the
state bar building and vacant at that
time, should be turned into a museum
memorializing the many great lawyers
in the history of the state of Alabama.
The implementation of the idea of an

Alabama Lawyers’ Hall of Fame origi-
nated during the term of state bar Presi-
dent Fred Gray. He appointed a task
force to study the concept, set up
guidelines and provide a recommenda-
tion to the board of bar commissioners.
The committee report was approved in
2003 and the first induction took place
for the year 2004. Since then, 45 lawyers
have become members of the hall of
fame. The five newest members were in-
ducted May 2, 2014.
A 12-member selection committee con-

sisting of the immediate past president of
the Alabama State Bar, a member ap-
pointed by the chief justice, one member
appointed by each of the three presiding
federal district court judges of Alabama,
four members appointed by the board of
bar commissioners, the director of the Ala-
bama Department of Archives and His-
tory, the chair of the Alabama Bench and
Bar Historical Society and the executive
secretary of the Alabama State Bar meets
annually to consider the nominees and
make selections for induction.
Inductees to the Alabama Lawyers’

Hall of Fame must have had a distin-
guished career in the law. This could be
demonstrated through many different
forms of achievement−leadership, serv-
ice, mentorship, political courage or pro-
fessional success. Each inductee must
have been deceased at least two years at
the time of their selection. Also, for each
year, at least one of the inductees must
have been deceased a minimum of 100
years to give due recognition to historic
figures as well as the more recent
lawyers of the state.

The selection committee actively solic-
its suggestions from members of the bar
and the general public for the nomina-
tion of inductees. We need nominations
of historic figures as well as present-day
lawyers for consideration. Great lawyers
cannot be chosen if they have not been
nominated. Nominations can be made
throughout the year by downloading the
nomination form from the bar’s website
and submitting the requested informa-
tion. Plaques commemorating the in-
ductees are located in the lower rotunda
of the judicial building and profiles of all
inductees are found on the bar’s website
at https://www.alabar.org/membership/
alabama-lawyers-hall-of-fame/.
Download an application form at

https://www.alabar.org/assets/uploads/
2014/08/Hall-of-Fame-Nomination-Form-
2015.pdf and mail the completed form to:
Sam Rumore
Alabama Lawyers’ Hall of Fame
P.O. Box 671
Montgomery AL 36101
The deadline for submission is March

1, 2015.

Judicial Award of Merit
The Alabama State Bar Board of Bar

Commissioners will receive nominations
for the state bar’s Judicial Award of
Merit through March 13, 2015. Nomina-
tions should be mailed to:
Keith B. Norman, secretary
Board of Bar Commissioners
P.O. Box 671
Montgomery AL 36101-0671
The Judicial Award of Merit was estab-

lished in 1987. The award is not necessar-
ily an annual award. It must be presented
to a judge who is not retired, whether
state or federal court, trial or appellate,
who is determined to have contributed
significantly to the administration of jus-
tice in Alabama. The recipient is presented
with a crystal gavel bearing the state bar
seal and the year of presentation.
Nominations are considered by a

three-member committee appointed by
the president of the state bar, which
then makes a recommendation to the
board of bar commissioners with respect
to a nominee or whether the award
should be presented in any given year.
Nominations should include a detailed

biographical profile of the nominee and

a narrative outlining the significant con-
tribution(s) the nominee has made to
the administration of justice. Nomina-
tions may be supported with letters of
endorsement.

Local Bar Award of
Achievement
The Alabama State Bar Local Bar Award

of Achievement recognizes local bar asso-
ciations for their outstanding contribu-
tions to their communities. Awards will be
presented during the Alabama State Bar’s
2015 Annual Meeting at the Grand Hotel
Marriott Resort & Spa in Point Clear.
Local bar associations compete for

these awards based on their size–large,
medium or small.
The following criteria are used to

judge the contestants for each category:
• The degree of participation by the
individual bar in advancing pro-
grams to benefit the community;

• The quality and extent of the im-
pact of the bar’s participation on
the citizens in that community; and

• The degree of enhancements to the
bar’s image in the community.

To be considered for this award, local
bar associations must complete and
submit an award application by June 1,
2015. Applications may be downloaded
from www.alabar.org or obtained by
contacting Christina Butler at (334) 269-
1515 or christina.butler@alabar.org. �
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Short articles of general 
interest are always welcomed
from ASB members. All materials
submitted for publication in the
Addendum are subject to editing
for style, space and content.

Send submissions as Word docu-
ments to margaret.murphy@
alabar.org. The deadline 
for the December issue is 

November 10.
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M C L E  D E F I C I E N T ?

Are You Chronically Deficient? 
Then You Really Should Read This!

By Angela Parks, director, ASB Regulatory Programs, angela.parks@alabar.org

Most Alabama lawyers are extremely conscientious
about complying with the annual MCLE requirement–a 
responsibility imposed on all of us by the Supreme Court
of Alabama. The requirement is meant to ensure that we all
continue to hone our skills and stay updated on changes in
the law. Of course, plans can go awry and sometimes prob-
lems arise: a sudden illness, a death in the family or a job
loss can throw you off track. The Alabama State Bar has
ways to help you through those events. One tool is the
MCLE Deficiency Plan.
Deficiency plans were designed for attorneys who, be-

cause of an unusual and infrequent circumstance, were un-
able to fulfill their annual 12-hour MCLE requirement on
time. Most of the lawyers across this state will never re-
quest a deficiency plan during their career, but that is not
true for everyone. Slowly but surely, the number of defi-
ciency plans requested each year has been climbing. And
the reasons given for these numbers of deficiency plans
are increasingly not unusual, unforeseeable or infrequent–
often the reason is simply a lack of planning.
The MCLE Commission has become concerned about the

number of attorneys who repeatedly request deficiency
plans. For some attorneys, a deficiency plan has become a
chronic need. In plain terms, the option for a deficiency
plan is being abused. This issue was partially addressed in

2011 with the addition of MCLE Rule 8.E, which provides
that requests for the approval of successive deficiency plans
will not be considered without a showing of good cause.
At the request of the MCLE Commission, on September

19, the Board of Bar Commissioners approved the adop-
tion of MCLE Regulation 8.6, which provides that, “In order
to make a showing of good cause pursuant to MCLE Rule 8.E,
after the approval of two successive deficiency plans, an attor-
ney shall appear before a panel consisting of the MCLE Direc-
tor, a representative of the MCLE Commission, and a
representative of the Office of General Counsel to explain why
a further deficiency plan should be granted. The attorney
shall be notified in writing of the decision of the panel.” The
new regulation becomes effective immediately.
The MCLE Commission has directed that a letter be sent

to the attorneys who will be affected this year by the new
regulation, to advise them of the new procedure while
they still have the balance of the year to take action to
avoid another MCLE deficiency. Monitoring deficiency
plans in this manner each year will now become a routine
part of our annual responsibilities.
If you have had two or more deficiency plans in the past

three years, we strongly urge you to make plans now to en-
sure that you are MCLE-compliant by midnight, December
31, 2014. �



October 2014 Alabama State Bar Addendum |5|

Throughout the design process for your new alabar.org, we
have aimed to present information in an easy-to-read format.
However, we understand that the smaller font sizes and varying
colors in some places, such as the results of our Member Search,
may be difficult to read for some members and visitors. Most
modern web browsers include the ability to zoom in on pages,
increase minimum font size and modify the color settings of
webpages. Below is a guide to making use of these features.

All Browsers
In all browsers, it is possible to zoom in on a page by press-

ing the Ctrl (or ⌘ on a Mac) and + keys at the same time. You
can press these keys repeatedly to zoom in further. To reset
zoom, press Ctrl and 0 (zero).

Internet Explorer
In Internet Explorer 8 and above, you can set your preferred

zoom level from the View menu. To reach these settings, press
the Alt key on your keyboard to bring up the menu bar at the
top of the window and then click View.

If you wish to only zoom in on fonts, or to remove color from
webpages, press the Alt key on your keyboard, click Tools and
then Internet Options. In the bottom right of the Internet Op-
tions dialog, click Accessibility.

Tips on Fonts
And Colors in
Your Browser

(Continued on page 6)

The Alabama State Bar recently an-
nounced that Montgomery attorney
Tom Methvin is the recipient of the
2014 Harold Albritton Pro Bono Lead-
ership Award.
Methvin is a principal attorney with

Beasley, Allen, Crow, Methvin, Portis
& Miles PC, where he is also the man-
aging attorney. He began his career
with the firm in 1988, shortly after
graduating from the Cumberland
School of Law. Methvin also gradu-
ated from the University of Alabama
with a degree in corporate finance.
Methvin is a past president of the Alabama State Bar (2009-

2010) and the Montgomery County Bar Association (1996). He
has contributed greatly to the pro bono efforts across the state
to bring awareness to the need for volunteerism in the legal
community.
“Tom has an intense commitment to the fundamental princi-

ples of equal protection and equal justice,” said Alabama State
Bar President Rich Raleigh. “He has worked zealously, both dur-
ing his presidency and after, to help Alabamians through out-
standing pro bono service, encouraging every lawyer and law
firm to become involved and emphasizing how every Alabama
lawyer has a responsibility to render public interest legal service.”
Created in 2011, the award is named for Judge W. Harold Albrit-

ton, who established the Alabama State Bar Volunteer Lawyers
Program in 1991. It was presented to Judge Albritton at the 2011
fall admission ceremony, honoring his vision and leadership. The
Albritton Award is now presented annually to an attorney who
has shown leadership and commitment to improving pro bono
legal services to Alabama’s low-income citizens.
“The overriding message of Tom’s service as president of the

Alabama State Bar was that lawyers had a duty to render pro
bono service, and even after his presidency he actively encour-
aged participation in local and state volunteer lawyer pro-
grams,” said Mike Martin, executive director of the
Montgomery County Bar Volunteer Lawyers Program.
Other past recipients include Samuel N. Crosby and Alyce M.

Spruell. �

Methvin
Named 2014
Recipient of
Albritton
Award

Methvin
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Here, you can choose “Ignore font sizes specified on web
pages” to be able to choose your preferred font size from the
View > Text Sizemenu, or “Ignore colors specified on web
pages” to default to black type, white background, blue unvis-
ited links and purple visited links. You can change these de-
fault colors by clicking Colors at the bottom of Internet
Options and unchecking “Use Windows colors.”

Firefox
Note: Mac users do not need to press Alt when following the in-

structions below. The menu bar is always visible at the top of your
screen.

To zoom in on web pages in Firefox, follow the tips above
under All Browsers. Firefox also allows you to easily zoom only
the text on pages by pressing the Alt key on your keyboard,
then clicking the Viewmenu, mousing over Zoom and click-
ing “Zoom Text Only.” You can then press Ctrl (or ⌘) and + or
- to zoom in and out.
You can also set a minimum font size. Press the Alt key on

your keyboard, click Tools in the menu bar and then Options
in the Tools menu. Click the Content tab and then the Ad-
vanced button. Choose your minimum font size from the
dropdown.

Here in Content, you can also choose your own Colors. Click
the Colors button and then uncheck Allow pages to choose
their own colors, instead of my selections above to override
what pages set.

TIPS ON FONTS AND COLORS IN YOUR BROWSER

(Continued from page 5)
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Chrome
To zoom in on pages, follow the instructions above under All

Browsers. Chrome does not offer built-in methods to change
colors, but you (or your IT department) can install an extension
like Change Colors (https://chrome.google.com/webstore/detail/
change-colors/jbmkekhehjedonbhoikhhkmlapalklgn) to do so.
To set a minimum font size, click the Menu button and then

Settings. At the bottom of the window, click Show advanced
settings… and scroll down to Web content. Click the Cus-
tomize fonts… button. Near the bottom of the dialog that
comes up is the Minimum font size slider. Click any point on
it, or click and drag the sliding box, to increase or decrease the
minimum font size.

Safari (Mac)
To zoom an entire page, follow the instructions above under

All Browsers. To zoom in on text only, increasing the font size,
click the Viewmenu in your menu bar and then check Zoom
Text Only.

You can then use ⌘ and + or - to increase and decrease font
size. You can also set a minimum font size for web pages–click
Safari in your menu bar, then Preferences and then the Ad-
vanced tab at the end. Check the box labeled “Never use font
sizes smaller than” and choose your preferred font size in the
dropdown to the right.

Unfortunately, Safari does not offer a quick and easy way to
override colors on a website. We recommend installing (or hav-
ing your IT department install) Firefox or Chrome.

We welcome your
feedback!
If you have any other questions, or want to share your expe-

rience with your new alabar.org, please go to https://www.
alabar.org/contact/ and send us a message. �
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For more than 25 years, the media
and legal commentators have identified
an increase of work-related violence to-
ward the legal profession. While there is
no national method for reporting these
threats and acts of violence at a state
level, surveys conducted to date in 11
states show that they do regularly occur.
A survey has been created to ascer-

tain the nature and frequency of the
threats and violence. This survey will re-
main open until November 30, 2014 and
the results will be submitted as a pro-
posed article for The Alabama Lawyer.
Please go to https://www.surveymonkey.
com/s/C2DQ2X6 and complete the sur-
vey, whether or not you have experi-
enced work-related threats or violence
in the legal profession. �

Survey of Threats and Violence Aimed at
Alabama’s Legal Profession 
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Making the Case for
Casemaker

To my clients,

I offer faithfulness, competence,
diligence and good judgment. I
will strive to represent you as I
would want to be represented
and to be worthy of your trust.

To the opposing parties and their
counsel, I offer fairness, integrity
and civility. I will seek reconcilia-
tion and, if we fail, I will strive to
make our dispute a dignified one.

To the courts, and other tribunals,
and to those who assist them, I
offer respect, candor and courtesy.
I will strive to do honor to the
search for justice.

To my colleagues in the practice of
law, I offer concern for your wel-
fare. I will strive to make our asso-
ciation a professional friendship.

To the profession, I offer assistance.
I will strive to keep our business a
profession and our profession a
calling in the spirit of public service.

To the public and our systems of
justice, I offer service. I will strive to
improve the law and our legal sys-
tem, to make the law and our legal
system available to all and to seek
the common good through the
representation of my clients.

(Approved by the Alabama Board
of Bar Commissioners 4/10/92)

If Casemaker looks a little different
today, it’s because its premium services
are now available to all ASB members
without charge. As a part of our contract
extension, you now have access to a
suite of tools that makes research faster
and easier, in addition to Casemaker’s
broad and comprehensive libraries,
which cover all 50 states and also pro-
vide federal materials–all as a benefit of
bar membership. The premium services
include CaseCheck+, CiteCheck and
CasemakerDigest.
CaseCheck+works like Shephard’s®

and KeyCite® to notify you right away of
negative treatment, identifying whether
your case is still good law. CaseCheck+
returns both positive and negative
treatments instantly as you research and
links to negative treatments so you can
quickly review the citation history. It
works seamlessly inside the new Case-
maker and doesn’t require any extra
steps to use.

CiteCheck analyzes every citation in
your brief (or your opponent’s) and pro-
vides you with a report of good law,
negative treatments and potential cita-
tion format errors. In just moments, you
have this critical information.
CasemakerDigest allows you to re-

ceive daily summaries of the latest state
and federal appellate decisions (within
12-24 hours of publication) classified by
practice area. Choose one area, a few or
all, and get exactly the information you
need when you need it.
If you’re not already enjoying Case-

maker, you can obtain access to the
basic library and the new premium fea-
tures by logging in at www.alabar.org
and selecting the Casemaker link from
your MyDashboard page. For help log-
ging in to the website, contact the Prac-
tice Management Assistance Program at
(334) 517-2242. For help with your legal
research, contact Casemaker Support at
(877) 659-0801. �

Lawyer’s Creed
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